
ONLINE WITH COMPUTER

  

 

ONLINE WITH COMPUTER

Book 7 

 

 

ONLINE WITH COMPUTERS 



1 

 

Table of ContentsTable of ContentsTable of ContentsTable of Contents    

Chapter 1.Computer Software..........................................................................................................2-5 

Chapter 2.More Features of MS Word 2010.....................................................................................6-10 

Chapter 3.Mail Merge in MS Word 2010.......................................................................................11-13 

Chapter 4 .Introduction to MS Access 2010...................................................................................14-16 

Chapter 5. Introduction to QBasic..................................................................................................17-21 

Test Paper 1....................................................................................................................................22-23 

Chapter 6.Functions in QBasic........................................................................................................24-26 

Chapter 7. Introduction to MS Excel 2010......................................................................................27-29 

Chapter 8. Editing in MS Excel 2010................................................................................................30-32 

Chapter 9. Formatting Cells in MS Excel 2010.................................................................................33-35 

Chapter 10. Microsoft Outlook 2010...............................................................................................36-37 

Test Paper 2......................................................................................................................................38 

 

 

 

 

 

  



2 

 

 

Chapter no. 1 

Computer software 

Learning objectives: 

After reading this chapter, students will be able to: 

• Describe computer software 
• Discuss types of computer software 
• Describe the functions of operating system 
• Discuss programming languages 
• Discuss language processors 
• Describe application software 
• Describe customized software 

Plan for achieving the learning objectives: 

Step 1:Reinforce the concept of computer software and define the term computer software to 
students and explain types of software to students. 

Step 2:Discuss with students the types of system software and explain the functions performed 
by operating system. 

Step 3:Reinforce the concept of programming languages and introduce students with language 
processors. 

Step 4:Make sure students are able to differentiate between application software and 
customized software. 

Step 5:Discuss the must know, now you know and key terms given in the end of chapter. 

Step 6:Use suitable examples to explain the mentioned steps. Make sure to use computer lab so 
that students can develop better idea of software. 

Page no. 7 

Answers of check your knowledge  

Multiple choice Questions 

1. b 2. a 3. c 
 

Answers of Exercise  
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Page no. 10, 11 

Exercise A 

1. b 2. a 3. b 
4. b 5. c 6. b 

 

Exercise B 

1. accessories   2. java 3. compiler 4. tailor-made 
software  

5. low level & high level 6. backup utility 7. hypertext preprocessor 
 

Exercise C 

1. × 2. × 3. ���� 
4. ���� 5. ���� 6. ���� 

 

Exercise D 

1. Operating system is a system software that controls the overall activities of a computer. 

2. System software and application software are types of software. 

3. Android, Microsoft windows, Mac OS X and windows phone are operating systems used 

nowadays. 

4. James A. Gosling is known as father of Java programming language. 

5. A language processor is known as translator program, it is used to convert the high-level 

language code to machine language code.  Assembler, compiler and interpreter are types 

of language processors. 

6. Following is the difference between high level and low level language: 

High level language Low level language 

1. Easier to write a. Difficult to write 

2. Easier to test/ debug b. Difficult to test/ debug 
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3. Processing speed is low c. Processing speed is actually fast 

4. C++, Java are high level languages. d. FORTRAN, COBOL are low level 

languages 

 

7. DBMS means database management system, it is a collection of data and other related 

information, 

8. An application software is used to perform operations for a specific task. Packages and 

customized software are its various types. 

9. Following are the advantages of using high level languages: 

• Instructions are similar to English which makes high level languages easy to 

understand. 

• It is easy to write, correct and test programs written in high level language. 

• Programs written in high level languages can be executed by different computers. 

10. Utility program is a system software that improves the operationsof an operating system 

by providing additional and specialised functionality to it. It helps to keep your system in 

good condition by eliminating errors. Some of popular utilities are as follow: 

• Backup utility:  It allows to take backup copy of data or information on a disk. 

• Antivirus:          It scans computer viruses. 

• Data compression: It can compress the contents of a disk. 

• Network utilities:   It analyses the computer’s network connectivity. 

11. Customized software is made as per the specific requirements of an organization. For 

example, software made for hotel management system would be different from that of an 

airline reservation system. 
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12. Following are the tasks performed by operating system: 

• Operating system manages the system resources 

• Operating system manages the transfer of data to and from various peripheral 

devices. 

• Operating system manages the system security and performance. 

Page no. 12 

Exercise E 

Organize students in groups and ask them to take help from internet and find out information 
about various operating systems used in mobile phones. 

Exercise F 

1. INTERPRETER 

2. ASSEMBLER 

3. DBMS 
4. COBOL 

5. JAVA 

6. COMPILER 

In the lab 

Organize students in different groups, ask them to take help internet and find whether 
FORTRAN, COBOL, BASIC, PASCAL are compiler based languages or interpreted languages. 
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Chapter no. 2 

More features of MS Word 2010 

Learning objectives: 

After reading this chapter, students will be able to: 

• Insert a table in MS  Word 2010 
• Define row, column, cell 
• Add/ delete rows & columns 
• Merge & split cells 
• Move and resize  a table 
• Change row height and column width 
• Apply table styles 
• Apply borders and shading to a table 
• Insert a watermark in a document 
• Print a document 

Plan for achieving the learning objectives: 

Step 1:Reinforce the features of WORD to students. 

Step 2:Describe the characteristics of WORD to students 

Step 3:Demonstrate students how to insert table in WORD document 

Step 4:Describe students by demonstrating the properties of table in WORD 

Step 5:Explain the use of watermark also demonstrate how to insert watermark in WORD 
document. 

Step 6:Explain how to take print of a document 

Step 7:Discuss the must know, now you know and key terms given in the chapter. 

Step 8:Use suitable examples to explain the mentioned steps. 

Step 9:  Make sure to practically perform the characteristics of MS WORD 2010 in computer 
lab 

Page no. 24 

Answers of check your knowledge  

Multiple choice Questions 
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1. c 2. a 3. c 
Answers of Exercise  

Page no. 32 

Exercise A 

1. b 2. a 3. c 
4. b 5. b  

 

Exercise B 

1. Table resize handle 2. Splitting  3. Text, picture 
4. Tab  5. Table 6. Print current page  

 

Exercise C 

1. × 2. ���� 3. ���� 
4. ���� 5. × 6. × 

 

Page no. 33 

Exercise D 

1. It is a rectangular area formed by the intersection of a row and a column 

2. A watermark is a text or picture that appears in a faded manner behind the text of a 

document. Watermarks are used to prevent imitation of the documents. 

3. Tab key is used to move to next cell. 

4. Table style can be change by using commands from design tab. To change the table style, 

follow the following steps: 

• Click in the table 

• Click the design tab 

• Click more button, in the table style group. A gallery appears. 

• Choose and click any style you want to apply to your table. 

5. To merge cells, follow the given steps: 
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• Select the cells you want to merge. 

• Click the layout tab. 

• Click merge cells from the merge group. The cells get merged. 

6. To change the row height, follow the given steps: 

• Select the row from the table whose height you wish to change. 

• Click on the Layout tab. 

• Click on properties from table group. 

• The table properties dialog box appears. Click on the row tab. 

• Click on the Specify height check box to check it and type the required height. 

• Click on OK  button. The row height gets changed. 

7. To add column to a table, follow the given steps: 

• Place the cursor in the table where you want to insert a column. 

• Click the Layout tab. 

• Click insert right  or insert left from the rows and columns group. A new and 

empty column is inserted. 

8. To add borders, follow the given steps: 

• Click the table. 

• Click the Design tab. 

• Click Borders from the Table styles group. A drop down list appears. 

• Click Border and shading.  A dialog box will appear. 

• Choose styles, color and width of the border. 

• Click OK  button. 

9. To print a document follow the given steps: 
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Click the “File” tab, next select “Print” option from the menu that appears. Choose the 

pages to print in the page range box by selecting one of the following options available. 

• Print all pages to print all pages of document. 

• Print selection to print the selected content in a document. 

• Print current page to print only the page where the cursor is positioned. 

10. To add a watermark, follow the given steps: 

• Open the file/ document in which you want to add a watermark. 

• Click the page layout tab on the ribbon. 

• Click watermark  from page background group. 

• Click custom watermark. The printed watermark dialog box will opens. 

• Click picture watermark to add a picture if you want to add text watermark, click 

on text watermark. 

Exercise E 

Take students to computer lab and ask them to perform the activity in groups using MS WORD 

2010 software. Monitor students while they perform the activity. 

Page no. 34 

Exercise F 

1. Draw table 2. Eraser  3. Delete   

4. Shading  5. Borders  6. Formula 

7. Split table  8. Insert above or below 9. Properties  
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Exercise G 

1. Table 
2. Column 
3. Row 
4. Cell 
5. Watermark 
6. Design & layout 

In the lab 

Take students to computer lab, ask them to use MS WORD to create an invitation card to invite 
their friends on their birthday party. Instruct them to follow information from page no. 34. 
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Chapter no. 3 

Mail Merge in MS Word 2010 

Learning objectives: 

After reading this chapter, students will be able to: 

• Perform the mail merge in MS Word 
• Define Envelopes and Labels  

Plan for achieving the learning objectives: 

Step 1:Introduce students with the concept of Mail merge a feature used in MSWord. 

Step 2:Describe them how to perform mail merge in MS Word 

Step 3:Demonstrate students how to use this feature by demonstrating them on projector 
connected to your laptop. 

Step 4:Describe students different features used in mail merge. 

Step 5:Explain them about envelopes and labels. 

Step 6:Discuss the must know, now you know and key terms given in the chapter. 

Step 7:Use suitable examples to explain the mentioned steps. 

Step 8:  Make sure to practically perform mail merging features in MS Word. 

Page no. 45 

Answers of check your knowledge  

Multiple choice Questions 

1. b 2. a 3. c 
Answers of Exercise  

Page no. 46 

Exercise A 

1. b 2. b 3. a 
4. c 5. c  

 

Page no. 47 

Exercise B 
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1. Create  2. Start mail merge  

3. Main document, data source   4. Mail merge 
 

Exercise C 

1. × 2. × 3. � 
4. × 5. �  

 

Exercise D 

1. Mail merge process is mainly used to send same basic letter with little modification to 
large group of people, it is also used when  letters with identical informationhave to send 
to many people. 

2. Data source is the file that contains name and address, i.e. data of recipient. 

3. Mail document is the document that contains text of a letter. 
4. Mail merge process involves the following three steps: 

• Create the main document. 

• Create the data source. 
• Merging the main document and data source into a single document or letter. 

5. The recipients can come from either an existing file or table or you can create a new list 
by following the mentioned steps: 

• Click on Type a new list under select recipients 
• Click Create, The new address list dialog box appears. 

6. To insert address block or greeting line in mail merge document follow the following 
steps: 
Address block 

• Click on the location in your document where the data from the mail merge field 
need to be inserted 

• Click on address block. The insert address block dialog box opens. 

• Select the address elements you want to include and then click OK.  

Greeting line: 

• To add greeting line. Place the cursor where you want to add a greeting line. 
• Click on it. The Insert greeting line dialog box opens. 
• Select the fields you want included in your greeting line.  

• Click OK  
7. To create the envelopes, follow the given steps: 

• Click on the mailing tab on the ribbon. 

• Click on start mail merge from start mail merge group. A drop down menu 
appears. 
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• Click on Envelopes from the menu. The envelope options dialog box appears.  
• Choose the envelope size. You can also choose the font for the delivery process. 

• In the printing option tab, choose the feed method for the envelope. 

Exercise E:   Take students to computer lab and instruct them to invite parents to attend the 
PTM in your school using the mail merge feature.  

Exercise F:   Using the mail merge option from MS Word 2010, send the details of the 
function to your club members, create a schedule of event for the annual meeting. 

In the lab:  Take students to computer lab, ask them to use MS WORD to write a letter to 
invite four organizing members and 2 participants. Instruct them to use mail merge feature for 
writing letter. 
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Chapter no. 4 

Introduction to MS Access 2010 

Learning objectives: 

After reading this chapter, students will be able to: 

• Understand what is database management system 
• Start off on MS Access 2010 
• Know about various views of MS Access 2010 
• Know about how to add, edit or delete records. 

Plan for achieving the learning objectives: 

Step 1:Introduce students with the concept of MS Access and by database management system. 

Step 2:Demonstrate students how to start MS Access and how to create a database using this 
software. 

Step 3:Demonstrate students objects used in database. 

Step 4:Describe students different features used in MS Access. 

Step 5:Discuss the must know, now you know and key terms given in the chapter. 

Step 6:Use suitable examples to explain the mentioned steps. 

Step 7:  Make sure to practically perform MS Access to create database. 

Page no. 59 

Answers of check your knowledge  

Multiple choice Questions 

1. a 2. b 3. a 
 

Answers of Exercise  

Page no. 60 

Exercise A 

1. c 2. c 3. c 4. b 
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Exercise B 

1. MS Office 2. Forms  3. Pivot chart 

 

Exercise C 

1. � 2. × 3. × 4. × 
 

Exercise D 

1. Following are the various views of a table: 

• The design view: This view is used to give the field name, data type and the 

description of field. 

• To datasheet view: This view shows the table with the data inside it. It is 

convenient to add, delete or edit data using this view. 

• PivotTable view: This view provides a useful way to summarize data about 

groups of records. 

• Pivot chart view: This view creates a chart from the associated PivotTable view. 

2.        

3.  

4. To delete a field follow the following steps: 

• Place cursor on the field to be deleted. 

• From the Design tab of the Table tool click on the Delete rows button. 

• MS Access shows a dialog box on whether you want to permanently delete all the 

fields and the data inside the fields. 
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Page no. 61 

Exercise E: Organize students in different groups and instruct them to use MS Access to draw 

a table which contains 5 fields, fill the fields with names, roll no’s, cricket, football, badminton. 

Fill data by taking response from your friends, and fill the fields with Yes/ No for all the sports. 

Exercise F 

1. Insert row 
2. Delete row 
3. Table design 

In the lab 

Take students to computer lab, ask them to use M Access to create a table with fields like Name, 
address, country, age, class studying. Perform various operations like deleting, adding fields to 
the table also make sure to delete or add record from the table. 

Note: Perform all activities in computer lab. 
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Chapter no. 5 

Introduction to QBASIC 

Learning objectives: 

After reading this chapter, students will be able to: 

• Understand Basic and QBasic languages 
• Discuss the components of QBASIC screen 
• Describe statements of QBASIC  
• Describe elements of QBASIC 
• Discuss various operations in QBASIC 
• Save a program 
• Run a program 
• Open a saved program 
• Exit from QBASIC 

Plan for achieving the learning objectives: 

Step 1:Introduce students with the concept QBASIC. 

Step 2:Demonstrate students how to start QBASIC. 

Step 3:Demonstratestudent’scomponents of QBASIC. 

Step 4:Describe students QBASIC commands. Also explain them about the elements of 
QBASIC. 

Step 5:Discuss the operators used in QBASIC. 

Step 6:Explain students how to save a program, how to open an existing program, how to 
execute and how to exit QBASIC. 

Step 7:Discuss the must know, now you know and key terms given in the chapter. 

Step 8:Use suitable examples to explain the mentioned steps. 

Step 9:  Make sure to practically perform all commands of QBASIC using QBASIC software. 

Page no. 64 

Answers of check your knowledge  

Multiple choice Questions 

1. b 2. a 3. c 
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Answers of Exercise  

Page no. 70 

Exercise A 

1. b 2. b 3. c 4. b 5. b 
 

Exercise B 

1. arithmetic, 
relational, 
logical, string 

2. minimize, 
maximize, 
close 

3. programmer   4. integrated 
development 
environment  

5. operator 

 

Exercise C 

1. × 2. � 3. � 4. × 5. � 6. � 
 

Exercise D 

1. John George Kemenyand Thomas Engene Kurtz developed BASIC language. 

2. Keywords are those words which are already defined in the programming language and 

have special meanings. They are also called reserved words. Some keywords in QBASIC 

are CLS, PRINT, LET, LEN& INT. 

3. A program is a set of instructions given to computer to be performed and carried out in a 

certain order to accomplish a particular task. 

4. LET statement is used to store the value in some variable or assign a value to a variable. 

5. An operator defines the type of operation to be performed on data. 

6. INPUT command is used to take data from the user while the PRINT command is used to 

get output of the program. 

7. To execute or run a program, follow given steps: 

• Click the run menu present on the menu bar 
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• Click on the start option. You will see the status messages “creating .EXE” File or 

“starting program” in the window. 

• You may also press F5 to run the program. 

8. Following are the components of QBASIC screen. 

• Title bar 

• Menu bar 

• Status bar 

• Program window 

9. To save a program, follow the given steps: 

• After typing the whole program correctly, click file menu. 

• Click the save option. The ‘save as’ dialog box appears. 

• Type the file name in the file name box. 

• Click OK  

10. Character set, constants, variables and keywords are basic elements of QBASIC.  

For detail see page no. 67. 

11. To open a saved program, follow the following steps: 

• Click on File menu. A sub menu appears. 

• Click on Open option, the open dialog box appears. All saved program will 

appear in a separate box named as files. 

• Select and click the file you want to open. The selected file name appears in the 

file name box. 

• Click OK.  Your selected file opens up on the screen. 
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12.  Arithmetic operators, relational operators, logical operators and string operators are 

different types of operators in QBASIC. 

Page no. 61 

Exercise E:  

CLS 

Input "enter the base"; b 

Input "enter the height";h  

let A = 1/2*b*h 

Print" The area of triangle=";A 

End 

Press F5 

Enter the base: b=15 

Enter the height: h= 5 

The area of triangle=A=37.5 

Exercise F 

1. PROGRAM  
2. MICROSOFT  
3. LET 
4. PRINT 
5. INPUT 
6. OUTPUT 
7. CLS 

In the lab 

Take students to computer lab, ask them to write a program using QBASIC, let students work in 
groups. 
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Program: 

CLS 

PRINT “enter two numbers” 

INPUT a 

INPUT b 

LET c= a + b 

PRINT c 

END 
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Test Paper 1 

(Based on Chapters 1 to 5) 

Page no. 72 

Part A: 

1. Mnemonics 2. Interpreter  3. Splitting  4. 5. QBASIC 
 

Part B: 

1. T 2. T 3. T 4. T 5. F 
 

Part C: 

Column A Column B 
 

1. Provides an interface b/w the user and computer a. Layout tab 

2. Low level & high level are types of   b. Query 

3. You can add rows and columns in the table using c. Mailings 

4. Step by step mail merge wizard is in which tab of 

MS-Word 

d. Operating system 

5. A selective retrieval of the data in table e. Programming language 

 

Part D: 

Note: Let students themselves attempt the questions as it is for their self-assessment  

1. See page no. 8 
2. See page no. 48 
3. See page no. 68 
4. Program: 

CLS 
Input " Enter any number" ;A 
Input " Enter any number" ;B 
Let Sum = A+B 
Let Average =Sum/2 
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Print" The sum=" ;Sum 
Print" The Average is " ;Average 
End 
 

5. See page no. 10 

. 
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Chapter no. 6 

Functions to QBASIC 

Learning objectives: 

After reading this chapter, students will be able to: 

• Describe functions in QBASIC 
• Discuss string function 
• Recognize the functions used in QBASIC 

Plan for achieving the learning objectives: 

Step 1:Introduce students with functions of QBASIC. 

Step 2:Demonstrate students how to use different functions in QBASIC. 

Step 3:Demonstrate student’s syntax of functions in QBASIC. 

Step 4:Discuss the must know, now you know and key terms given in the chapter. 

Step 5:Use suitable examples to explain the mentioned steps. 

Step 6:  Make sure to practically perform all functions of QBASIC using QBASIC software. 

Page no. 82 

Answers of check your knowledge  

Multiple choice Questions 

1. a 2. c 3. c 
 

Answers of Exercise  

Page no. 84 

Exercise A 

1. b 2. a 3. c 4. a 5. a 
 

Exercise B 

1. string, numeric 2. 148.4132 3. Mod 4. ONLINE 
WITH 
COMPUTER 

5. time 
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Exercise C 

1. × 2. � 3. � 4. × 5. × 6. � 
 

Exercise D 

1. A string is a group of characters and numbers or special characters enclosed within 

double quotes. 

2. Two types of library functions are string function and numeric function. 

3. Numeric functions are mathematical or numeric functions in QBASIC which are 

designed to perform some mathematical operations such as finding the square root of a 

number, mod, exponential value, etc. 

4. Absolute number of a number is the number itself without any sign. 

5. The LEFT$ ( ) function is used to display the string characters starting from the leftmost 

position and the RIGHT$( ) function is used to display string characters from the right 

position of the string. 

6. The MID$ ( ) function is used to get the specified number of characters from the middle 

of a given string. For example:  

CLS 

a$= MID$ (a$, 4, 4) 

print a$ 

END 

Output: $$$$ 

7. SQR ( ) function is used to calculate the square root of a number 

E.g: PRINT SQR (16) 

Output: 4 
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8. The INT ( ) function is used to return an integral value for a number. 

9. The DATE function is used to display current date on the output screen while TIME 

function is used to display the current time on output screen. 

10. The LCASE$ ( ) function is used to convert the given string into lower case and UCASE$ 

( ) is used to convert the given string into uppercase. 

11. The ABS ( ) function is used to find the absolute value of a number while the VAL ( ) 

function is used to highlight a number or numbers from a string. 

Exercise E:  

1: 

I . INPUT P-Q INPUT P or INPUT Q 
II . LET A; 5 LET A=5 

III . PRINT “School PRINT “School” 
IV . LET LET a=0 
V. PRINT LEN(QBASIC is easy) PRINT LEN(“QBASIC is easy”) 

VI . PRINT String$(5, M);  
VII . PRINT DATE; PRINT DATE$ 
 

2: Outputs 

I.  7 
II.  hello friends 

III.  ONLINE WITH COMPUTER 
IV.  15 
V. L 

VI.  16 
VII.  125 

VIII.  -10 
IX.  Error 

 
In the lab 
Take students to computer lab, ask them to write a program following instructions from the in 
the lab 
 

 



27 

 

Chapter no. 7 

Introduction to MS EXCEL 2010 

Learning objectives: 

After reading this chapter, students will be able to: 

• Start MS EXCEL 2010 
• Define spreadsheet, workbook 
• Identify components of MS EXCEL screen 
• Define cell, cell address & range of cells 
• Open a new workbook 
• Define types of data to be put into a cell 
• Insert data in cells 
• Move in an Excel sheet using shortcut keys 
• Save a workbook 
• Close a workbook 
• Open a saved workbook 
• Exit from MS Excel 

Plan for achieving the learning objectives: 

Step 1:Introduce students with MS Excel 2010. 

Step 2:Demonstrate students how to start Excel. 

Step 3:Demonstrate student’s components of MS Excel, also explain to perform various tasks 
using MS Excel. 

Step 4:Discuss the must know, now you know and key terms given in the chapter. 

Step 5:Use suitable examples to explain the mentioned steps. 

Page no. 89 

Answers of check your knowledge  

Multiple choice Questions 

1. a 2. a 3. b 
 

Answers of Exercise  

Page no. 95 

Exercise A 



28 

 

1. a 2. a 3. b 4. a 5. b 
 

Exercise B 

1. 32767 2. Cell  3. worksheet 4. address  

5. workbook  6. close  7. formula 

Exercise C 

1. × 2. � 3. � 4. × 5. × 6. � 
 

Exercise D: 

1. When you select or highlight a block of cells, them the area formed by the block of cells 
is known as range of cells. 

2. In a worksheet, the horizontal lines are called the rows while the vertical grids form a 
column. The intersection of row and column is a cell. 

3. There are 1,048,576 rows and 16,384 columns in a worksheet. 
4. Cell address is the column + row number given to a cell by which it is referred. 
5. A spreadsheet consist of data and information organized in the form of rows and 

columns. These are commonly used to perform different kinds of calculations. 
Spreadsheets are also used in various field like school, business organizations and etc. 

6. Title bar, quick access toolbar, ribbon, formula bar, worksheet, workbook, sheet tab, 
status bar, cell are some of components of MS Excel sheet. 

7. To save a workbook, follow given steps: 
• Click the “file” tab. 
• Click “save”. The ‘Save As’ dialog box appears on the screen. 
• Type the name of the file in the file name box. 
• Click save button. 

8. To open a new workbook, follow the given steps: 
• Click ‘file’ tab. A list of options appears. 
• Click ‘New’ option. 
• Now under available templates click or Blank workbook or click on Create 

button. 
9. We can enter numbers or text into Excel worksheet or in a cell. 
10. To open a saved workbook, follow these steps: 

• Click File tab. 
• Click open. The open dialog box opens. 
• Select the file you want to open. The file name appears in the file name box. 
• Click open button. The file gets opened on the screen. 
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Exercise E:  

Organize students in different groups and assign them with internet, instruct them to take help 

from internet to collect information about famous British Olympians.  Instruct them to follow 

instructions from page no. 96, 97 and make a table in MS Excel. 

Page no. 97 
Exercise F: 

1. Cells 
2. alignment 
3. Clipboard 
4. Editing 
5. Styles 
6. Font  

 
In the lab 
Take students to computer lab, ask them to perform the activity mentioned on page no. 97.  
Instruct students to work in groups. 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



30 

 

Chapter no. 8 

Editing in MS EXCEL 2010 

Learning objectives: 

After reading this chapter, students will be able to: 

• Select cells/ rows/ columns 
• Select multiple range of cells 
• Name a range 
• Cut, copy, paste the cell contents 
• Insert cells, rows, columns 
• Adjust row, column height 
• Use autofill feature 

Plan for achieving the learning objectives: 

Step 1:Introduce students with editing in MS Excel 2010, describe and demonstrate how to 
select cells. 

Step 2:Demonstrate students select multiple range of cells 

Step 3:Demonstrate student’s how to cut, copy paste the contents of MS Excel, and also explain 
to insert cells, rows and columns.  Introduce students with the concept of autofill. 

Step 4:Discuss the must know, now you know and key terms given in the chapter. 

Step 5:Use suitable examples to explain the mentioned steps. 

Page no. 104 

Answers of check your knowledge  

Multiple choice Questions 

1. b 2. a 3. b 
 

Page no. 120 

Answers of check your knowledge  

Multiple choice Questions 

1. c 2. c 
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Answers of Exercise  

Page no. 121 

Exercise A 

1. b 2. a 3. b 4. c 5. b 
 

Exercise B 

1. F2 2. 12.75 & 8.43 3. Status bar 4. Defined 
name 

5. Clipboard  

Exercise C 

1. � 2. ×  3. × 4. � 5. × 
 

Exercise D: 

1. Auto fill is the feature of MS Excel 2010 which allows us to enter a predefined series of 
data such as text or numbers. 

2. Extend indicator is used to selecta range of cells. 
3. Shift+ spacebar is used to select entire row while ctrl+ spacebar is used to select entire 

column. 
4. A block of neighboring cells or cells which are adjacent to each other. 
5. To select multiple range, select first range of cells, hold down ctrl key and select the next 

range, continue holding down the ctrl key and select another range of cells. When you 
finished release the ctrl key. 

6. To select a range that is out of view click in the first cell of range to be selected, press F8; 
the status will show the extend indicator, click in the lowerleft cell of the range until all 
the required cells are selected. To turn off the extend function press F8 or ESC key. 

7. To name a range select cell or range, click on formula tab, click define name from the 
defined names group, you will see two options click define names, the new name dialog 
box opens. Type the name for the range in the box and click OK.  

8. Insert a column: 
To insert a column, click column name to select the column and at where you want to 
insert a new column, click home tab               Insert, in cells group. Click insert sheet 
column option. You will see the selected column gets shifted towards right and a new 
column is inserted in its place. 
Delete a row: 
To delete a row, select the row or rows than click home tab, click delete from cells group, 
a list of options appears, click delete sheet rows to delete the selected row or rows. 
Adjust column width: 
To adjust column width, select column in worksheet by dragging through the column 
header, click on Home tab from ribbon, click on drop down from cells group, a list of 
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options appears. Select and click column width option under format heading, the column 
width dialog box appears, enter new width. Click ok.  

9. Auto fill feature is used in Excel to enter a predefined series of data such as text or 
numbers. 

10. To insert cells, select range of cells from worksheet, click on home tab, click insert from 
cells group; a list of options will appears, click insert cells. The insert dialog box opens. 
Choose appropriate option from insert dialog box and click OK. 

Exercise E:  

Take students to computer lab and ask them to use Excel 2010 to perform the group activity. 

Exercise F: 
1. Name manager 
2. Breaks  
3. Format as table 
4. Margins 
5. Clear  
6. Error checking  

 
Exercise G: 

1. Workbook 
2. Cell 
3. Clipboard 
4. Range 
5. Spreadsheet 
6. Row 
7. Column 
8. Formula 
9. Spreadsheet  

 
 
In the lab 
Take students to computer lab and ask them to use EXCEL 2010 to make a table. Instruct them 
to follow instructions from page no. 123. 
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Chapter no. 9 

Formatting cells in MS EXCEL 2010 

Learning objectives: 

After reading this chapter, students will be able to: 

• Describe formatting  
• Format font, text, numbers 
• Format border of selected cells 
• Add a background image to excel sheet 
• Add a theme to excel sheet  
• Insert a clip art image in MS Excel sheet 
• Insert wordart text in excel sheet 

Plan for achieving the learning objectives: 

Step 1:Introduce students with formatting in MS Excel 2010, describe and demonstrate how to 
format text, font and border of selected cells. 

Step 2:Demonstrate students how to format pattern and background color of cells 

Step 3:Demonstrate student’s how toadd a background image to excel sheet and how can we add 
themes to excel sheet. 

Step 4:Discuss the must know, now you know and key terms given in the chapter. 

Step 5:Use suitable examples to explain the mentioned steps. 

Page no. 128 

Answers of check your knowledge  

Multiple choice Questions 

1. b 2. a 3. c 
 

Exercise A 

1. a 2. a 3. c 4. a 
 

Exercise B 

1. theme 2. right  3. color, style  4. wordart 
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Exercise C 

1. × 2. � 3. × 4. � 
 

Exercise D: 

1. Formatting is the process of changing the font size, style, color, border pattern, 
alignment, etc. in order to make presentation more attractive. 

2. Cell size, visibility, organize sheets and protection are present in format cell dialog box. 
3. WordArt is a collection of different stylish decorative texts which includes many effects 

like shadow, colors and outlines etc. 
4. Alignment refers to the position in which the data is placed within the boundary of a cell. 
5. To change the font size and style, follow the given steps: 

• Select cells and click the font tab in the format cells dialog box. 
• Select font style and size by clicking the drop down list. 
• After making the required selections, click OK 

6. To add background image in Excel file, follow the given steps: 
• Open spreadsheet to which you want to add the background. 
• Click the page layout tab on the ribbon. 
• Click the background from page setup group. The sheet background dialog 

box opens. 
• Select the background image you want to add to your sheet.  The selected file 

name will appears in file name box. 
• Click on insert button. You will see image has been added to your spreadsheet. 

Exercise E:  

Organize students in groups and assign each group with a computer, ask them to use internet to 

collect data about the planets of solar system and make an excel file by providing information 

under the given headings. 

Follow instructions given on page no. 135. 

Exercise F: 
1.  
2. Protected workbook  
3. Protect sheet 
4. Translate  
5. Font 
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6. Undo 
 
In the lab 
Take students to computer lab and ask them to use internet to collect information about 10 
countries regarding capital, currency, languages, spoken etc. make an excel file using collected 
data. Instruct students to apply formatting to table. 
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Chapter no. 10 

Microsoft Outlook 2010 

Learning objectives: 

After reading this chapter, students will be able to: 

• Use MS Outlook 2010 
• Write email 
• Receive email 
• View email 
• Attach files 
• Print e-mail 
• Delete email 
• Reply to an email 

Plan for achieving the learning objectives: 

Step 1:Introduce students with Microsoft outlook 2010 

Step 2:Demonstrate students how to compose an email and send it to their friends. 

Step 3:Demonstrate student’s how to receive email and view it. Also explain by demonstrating 
how to attach a file with an email along with performing different actions on it. 

Step 4:Discuss the must know, now you know and key terms given in the chapter. 

Step 5:Use suitable examples to explain the mentioned steps. 

Page no. 139 

Answers of check your knowledge  

Multiple choice Questions 

1. b 2. b 3. c 
 

Answers of Exercise  

Page no. 143 

Exercise A 

1. a 2. c 
 

Exercise B 
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1. File 2. Review  3. Address box 

 

Exercise C 

1. × 2. � 3. × 
 

Exercise D: 

1. Resource pane, tabs, ribbon, status bar, contents pane are components of MS Outlook 
2010. 

2. Inbox is where all incoming messages land while outbox is where all outbound but not 
send messages are temporarily stored before being sent. 
 

3. Receiving mails: 
• Click send/ receive all folders command to send all the mails in outbox and receive mails. 

 
To check email: 

• When you open Outlook express it will automatically check for new mails, if it doesn’t 
do this then click the ‘Inbox’ under outlook data file in the resource pane. 

 
View a message attachment 

• Select the message 
• Right click the attachment icon 
• Select save attachments or click file then save attachment. 
• The save all attachments dialog box will open, 
• Double click the message so the message window opens. 
• Select save as from file tab. The save as dialog box opens. 
• In the file name box enter the name if it hasn’t already done so. 
• Click save button. 

 

In the lab 
Take students to computer lab, assist them by making their accounts on Hotmail.  Instruct them 
to use Outlook 2010 to reply to a mail, also mention them to reply the email to all members, use 
forward feature and then delete it. 

Make sure students are able to perform all actions. 
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Test Paper 2 

(Based on Chapters 6 to 10) 

Page no. 72 

Part A: 

1. 7777 2.  3. F8  4. 16 5. font  
 

Part B: 

1. F 2. T 3. F 4. F  5. T 
 

Part C: 

Column A Column B 
 

1. Str$() function is used to Illustration group 

2. a collection of worksheets   Name box and formula box 

3. to change the range name you must use  

     the  

Convert number to strings 

4. insert clip art is present in Workbook 

5. the formula bar contains two boxes Formula tab 

 

Part D: 

Note: Let students themselves attempt the questions as it is for their self-assessment  

1. See page no.  
2. See page no. 137, 138 
3. See page no. 95 
4. See page no. 102 
5. See page no. 129 

. 

 




